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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008 - 2009 to 2010 - 2011

Board Goal / —_— Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report
Policy Review > RRSD Policy Review 5 years Board
e continue minimum rotation
¢ refer Guidelines for Student Assessment Policy to Ad Hoc
1.0 Committee & Policy Review
) ¢ refer Student Placement Policy (IKA), Promotion & Retention
Guidelines to Ad Hoc Committee & Policy Review
» Trustee Code Ethics
» Annual Planning Process
Professional » Board — Administration Workshop Board
Development » Conflict of Interest Workshop Senior
2.0 » Board Senior Administration Workshop — Board Governance & Policy Administration
Discussion — Planning Process
Board / CEO > Policy developed review and implementation process 2008-2009 Board
@ | 3.0 | Evaluation Superintendent
g Planning > Review results of the Parent Survey as it relates to development of
] the Action Plan. 2008-2009
cC > Review declining enroliment, school consolidation / closures /
= 4.0 amalgamation and develop a long range approach to deal with this 2008-2011
((b] > Develop an annual Board work plan 2008-2009
> > Trimester report — review scheduling in conjunction with Board
(@] meetings versus Superintendent Evaluation 2008-2009
(5 Public Enhancing » Develop and implement a communication Protocol for Trustees and
Relations/ Trustee — Senior Administration 2008-2009
5.0 | communication | Administration
Communication
Enhancing > Alternate Education Presentations and School and Division Office
School Board tours each year 2008-2010
Communications | » Information from Board operations/activities in school newsletters 2008-2011
5.1 > Implement distribution of school newsletters to all Trustees (via
email) 2008-2009
> Review Trustee — School Administration meetings and format 2008-2009
Reporting to the | » Develop a plan to report to the community
5.2 Community » Publish information on budget and programs prior to budget 2008-2010
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008 — 2009 to 2010 — 2011

Divisional N -~ Target for Team
Ref. - | / Initiativ Activiti ) Progr Repor
© Priority Goa tiative ctivities Completion Leaders ogress Report
Appropriate Early Literacy > Implement Observation Survey of Early Literacy Achievement — 2008-2009 Grade 1
1.0 Education Program DIAL
— Early Numeracy » Math Recovery Training K-3 2008-2009 J. McKenzie
% 1.1
iddle Years Literacy uided Reading and Writing Process — On-Going - rade Groups
(m) Middle Years Lit > Guided Readi d Writing P On-Goi 2008-2009 | Grade G
N 1.2
"E Social Studies > Implementation of Grade 6 Curriculum and text 2008-2009 Grade Group
1.3
Q
-g Basic French » Continue implementation of AIM program 2008-2009 C. Stiles
O 14
njad
c
" Career Development  |» Career Preparation and Exploration SIC discontinued. Phase in 2008-2009 High School
(«}) 1.5 Career Development course Principals
Q|
=
(dp) Class Size & » Continue implementation of appropriate adaptations and 2008-2009 Division /
— | 1.6 Composition Project accommodations at junior high / senior high level at ECI School Team
c
o Healthy Life Styles Physical Education » Implementation of Grade 11/12 Physical Education Program. 2008-2009 J. Potter
prer) ransition to 29 credits for - an credits for -
-— 2.0 Transition to 29 credits for 2008-2009 and 30 credits for 2009
8 . 2010
- Professional Growth Behavioural » WEVAS, Restitution and Communicating with Parents (3 Yr) 2008-2009 R. Gray
"O | 3.0 |and Staff Development| Management
LU
BATL Project » Division Inservice 2007-2010 G. Butler
3.1
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008 — 2009 to 2010 - 2011

Divisional Goal / N Target for Team
Ref. o e Activiti . Progress Report
© Priority Initiative ctivities Completion | Leaders 9 P
Appropriate Update and » Develop new policies and make recommendations to the Policy 2008-2009 D. Parrott
Educations create new Committee J. Cline
Programs policies to » Revise existing policies where necessary G. Edwards
1.0 meet
Appropriate
Education Act
@ : . :
E Adaptation » Review and make changes Ongoing D. Parrott
] 1.1 Format » Transfer to computer program 2008-2009 G. Butler
o Student » Review existing policy / match with Provincial guidelines 2008-2009 D. Parrott
(@) 1.2 Support file » Make recommendations to Policy Committee if required Senior
2 ' guidelines » Inservice student support staff Administration
o Student » Create plan with Student Support staff to review file content 2008-2009 D. Parrott
i Support Files | > Implement and complete plan to purge/update/review files 2009-2010 A. Playter
o |13 » Complete file review in Division Office (Psychologist, Social Worker, 2009-2010 R. Gray
o Speech/Language clinicians) K. McNabb
Q
-5 Create post » Create and draft guidelines / pilot 2008-2009 D. Parrott
(7)) assessment » Review and finalize guidelines 2009-2010
guidelines for
"E 14 Resource
) Teacher
-g To continue » Complete and draft guidelines for working with these students. 2008-2009
Professional e Behaviour
a Development e Instructional / best practices
and develop e Assessment
1.5 Divisional .
guidelifnes in | > Inservice school staffs 2009-2011
area o
Autism and
FASD
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008 — 2009 to 2010 - 2011

Divisional Goal / N Target for Team
Ref. o cee - Activities . Progress Report
© Priority Initiative ctivitie Completion Leaders 9 P
IEPs » Continue inservicing on writing clear and concise |IEPs at each Ongoing D. Parrott
Resource Teacher meeting
1.6 » Evaluate success on new IEP format (template and writing IEP with 2009-2010
7)) . school teams)
E » Transfer to computer program 2009-2010 G. Butler
E Inservice > Portion of each Resource Teacher meeting 2008-2009 D. Parrott
O Resource
(o] Teachers on
= | 5 Communication | running
o . effective and
jd efficient
| - meetings
o g
Q. Website links | » Create links to reputable websites for staff and parents (for 2008-2009 D. Parrott
Q. for Student disorders, conditions, learning disabilities, etc.)
2.1 .
- . Services page
. Develop skills | » Continue to inservice staff with case studies at meetings Ongoing R. Gray
- Professional with Guidance
% 3.0 Development Counselors
- . .
v » Monitor established SuccessMaker program D. Parrott
(dp) » Workshops for Educational Assistant (2 x per year) M. Dalton
4.0 | SuccessMaker » SuccessMaker team meetings (School Admin, Resource Teachers
Educational Assistants), minimum x 1 year
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008 — 2009 to 2010 — 2011

Divisional Goal / N Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report
Appropriate LICT > Internet Access — Long term plan to improve internet access, creation Fall 2008 G. Butler
Education of RRSD WAN. Recommendations to Board K. McNabb
Program ¢ Manitoba Network R. Adams
e MTS - site survey to be done in the Fall 2008
» BATL /LwlICT — Reporting to Parents as per department requirements
Grade = KoB. oot Fall 2008 G. Butler
J. Hrymak
» Removal of one high school lab and replace with Portable Laptop
TECNNOIOGY ...ttt Fall 2008 G. Butler
1.0 » Review of High School Technology courses offered content, distance
>N education COMPONENT. ..........ccouuiiiiiiiiiiiiie e 2008-2009 G. Butler
O e LICT1&2
(@) e Grade 10 Distance Education component
i » Establishment of 12-15 BALT classrooms — all grade levels in the
) QVISION. ..o er oo 2008-2009 G. Butler
C e As per budget 2008-2009 J. Hrymak
'E, e Evaluations of BATL program
|d_) Student > Pilot of FC-Connect — Outcome based reporting for Grade K — 8 pilot 2008-2009 G. Butler
Assessment schools. L. Jago
e 1.1 e Forrest Elementary — all grades G. McNabb
3 ) e TCS—Grades5-8
-3 > Email accounts for all Grade 4 to 9 students using First Class 2008-2009 G. Butler
o software J. Hrymak
E Distance > Looking at ways to effectively offer distance education courses in the 2008-2011 G. Butler
Education division Sr. Adm.
O (1.2 e WebCT (blackboard)
O e Moodle
Professional Summer/Fall > Full and 2 day workshops in the following areas (see attached list of 2008-2009 G. Butler
Development Technology possible workshops) J. Hrymak
workshops e LwICT — Reporting to Parents
e First Class
2.0 e Classroom web pages
e FC-Connect
e BATL for Administration
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008 — 2009 to 2010 - 2011

Divisional Goal / N Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report
LwICT/BATL > Divisional Inservice — BYTE 2009 Winter 2009 G. Butler
> BATL — Continue with workshops for Admin on engaging students 2008-2009 G. Butler
e Engaging students
e Evaluation of BATL
> 2 day orientation for new staff Fall 2008 G. Butler
J. Hrymak
2.1
- > Workshops for BATL project teachers 2008-2009 G. Butler
(®)) e Planning lessons J. Hrymak
(@] e Engaging students
. e Grade Group meetings
O e Mentors
c e Student Assessment
- Enhanced » Creation, of online professional development using WebinR technology 2008-2009 G. Butler
8 0o 'Il')eafcher I e Distance learning for teachers, at their own pace place R. Adams
. rofessiona
- Development
.
9 Communication | Enhanced » Parent Portal using Maplewood Fall 2008 G. Butler
-3 Parent / e High Schools
o Student » Parent Portal — Parents using integrade Pro to view student marks, 2008-2009 G. Butler
Communicatio High school only
E n » Establish a policy with schools regarding Classroom and Teacher web 2008-2009 G. Butler
o pages J. Hrymak
0 e Type of information
3.0 e  When updates
e Program to use (First Class or Front Page)
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008 - 2009 to 2010 - 2011

Divisional Goal / A Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report

Communication | Implement the > Operation of the Rolling River Education Fund (RREF)................... 2008-2009 R. Klassen

(Budget & Rolling River e Implement Committee structure and meetings K. McNabb
Q 1.0 Financial Education Fund e Develop a communication/ promotion strategy
g ** | Reporting) (RREF) » Maintain operation of the RREF as per Policy...............ccvvvveeeeee... Ongoing
©
E Accountability | Research and » Investigate, recommend and develop a plan to implement a new 2008-2009 K. McNabb
LL. Implement and payroll / accounting software system (Current system is being L. Good
05 Accounts — eliminated in 2-3 years). Budget for replacement in 2009-2010 G. Butler

2.0 Payroll and Budget.
c Associated » Research and recommend additional systems that are integrated 2008-2011
o Systems with Account / Payroll System (Human Resources, Work Order,
o — Inventory, Budget, Assets, Student Information, etc.)
E Review , » Define needs and goals of inventory systems............c.cooiviinnen 2008-2009 K. McNabb
— Evaluate, » Review current systems G. Butler
v Revise and » Investigate alternatives L. Dobreen
2 Implement » Develop Policy and Regulation
C |21 ﬁppropriatde » Implement a comprehensive inventory process..........c.ccvevvuiiienen.n. 2009-2010
" — ) ssets an
E Consumables
y o) Inventory
< Systems
(7)) School » Maintain standards / policy / procedures for school fund / school fund 2008-2009 K. McNabb
(7)) Accountability fundraising (School Funds Manual) and Divisional School Cash Net L. Good
((}] accounting program for school funds (Type A)
c » Review and evaluate Audit process for School Funds
n 2.2 Improved » Develop and implement standard process for financial reporting to 2008-2010
= School — school communities for school based funds
(a1 Community » Investigate and implement GST rebate claim procedure for school
Communication funds.
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008- 2009 to 2010 - 2011

Divisional Goal / —_— Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report

Declining Develop and Develop long term options for education, school utilization, and or 2008-2011 K. McNabb
(o)) Enrollment Analyze Data school consolidation based on projected declining enroliment and R. Klassen
O |30 Plan for School review implications of Bill 28 — The Strengthening of Schools Act M. Janssen
c ' Enroliment relative to the long term plan.
o Forecasts /
c Trends
 — Provincial Compliance Develop and implement quarterly reporting / monitoring procedures 2008-2009 K. McNabb
L Requirement with Public and methodology for compliance with PSAB standards for March 31
06 Sector Financial reporting.

March 31 PSAB | Accounting
c Compliant Board Complete second PSAB compliant March 31 Financial Statement
(o) 4.0 | Financial Standards (Limited Procedures) and develop draft working audit file in 2008-2009
— Statement (PSAB) preparation for Comprehensive Audit Procedures in 09/10.
E Complete First PSAB compliant March 31 Financial Statement 2009-2010
"‘7; (Comprehensive Procedures) and full audit file.
c Support Staff Develop and implement a Support Staff Orientation Handbook 2008-2009 K. McNabb
e — Communication | Orientation (including relevant policy, procedures, payroll, benefits, accounts HR
E Handbook etc.)
O | 5.0 | (Administration)
<
n
7)) Develop and Orient and implement new WSH regulations with school Based K. McNabb
Qo Implement a Committees 2008-2011 L. Dobreen
E Workplace Survey to assess WSH training needs — develop opportunities to
¥ |51 Safety & Health provide WSH training.
-3 ' Program Develop and implement Job Hazard Analysis and Safe Work
m Procedures

Participate in MAST WHAM Software Project
Participate in WSH related partnerships with other School Divisions
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008 — 2009 to 2010 — 2011

Divisional Goal / A Target for Team
Ref. o e e Activiti . Progress Report
© Priority Initiative ctivities Completion Leaders 9 P
Declining Efficient » Maintain efficient routing 2008-2010 D. Tesarowski
Enroliment Routing
1.0
. Safe and > Asking RCMP to present at November Inservice 2008-2010 D. Tesarowski
"5_ Positive > Train mechanics on new testing software
@ | 2.0 Environment » Purchase new buses with adequate equipment (48 passenger or bigger)
g Healthy Lifestyle | Promote » Monitor no idle practices with Drivers and Division staff 2008-2010 D. Tesarowski
" — (Operating Environmentally | > Promote 2% Bio Diesel blend with Province of Manitoba for every user.
E 3.0 |Environmentally) | Friendly » Promote rideshare and route shortcuts when possible
wjd Fuel
|-
o Efficient and Monitoring Buses | » Investigate / test GPS tracking of school buses 2008-2011 D. Tesarowski
Q. Accountable
N 40 Operation of
g School Buses
l: Modernize » Explore the use of electronic mapping (Repro-map) 2008-2010 D. Tesarowski
5.0
Personnel Preparation of > Driver training, recruitment, and/ or retention programs 2008-2009 D. Tesarowski
staff for promotion
6.0 as others retire
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008 - 2009 to 2010 - 2011

Divisional Goal / —_— Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report
Safe & Capital “D” » Erickson Elementary School — New gym floor 2008-2009 L. Dobreen
Positive Projects » Schools — Flooring Replacement (Onanole, TCS, Erickson Elem.) Maint. Staff
Learning » Schools — Gym Lighting Replacement Contractors
1.0 | Environment » MCI — Steps
» ECI — Steps
(7)) » Forrest — Vice Principal’s office
c » Asbestos Removal — RCI, TCS, Maintenance Shop
(o) Playground | » Working on plan for Forrest and Rivers Elementary 2008-2011 L. Dobreen
— Maintenance | » TCS — New sand for swing sets and check schools for sand
S | 1.1 and Repair » Work within our budget to improve our play structures
— ) » Multi-year plan is ongoing
((b] » Encourage Parent Groups to be involved and be partners with the
o Division
O Summer » Shingle storage shed at Erickson Collegiate 2008-2009 L. Dobreen
Projects » Drywall ceilings in shower room at Erickson Collegiate Maint. Staff
> 1.2 > Entrance doors at Rivers Collegiate
et » Complete maintenance items at all schools
— » Erickson Collegiate — Water and Sewer Replacement
o School » Forrest Elementary (summer) 2008-2009 L. Dobreen
© Painting » 2 classrooms at Tanner’s (summer)
LL 1.3 Projects » Rivers Collegiate and Minnedosa Collegiate — (school year)
~ : » Painting classrooms during school year; hallways and some classrooms
(¢} done during breaks
O » All schools - exterior painting if time permits
c Long Term » Complete a review of Division Office, Maintenance and Garage facilities 2008-2009 L. Dobreen
(1+] Strategy for | » Meet with Operations Committee and new Administration to develop a
c 1.4 Division plan for future utilization of the facilities
Q ) Office,
e Garage &
_E Maintenance
(1] P.S.F.B > Rivers Collegiate ROOf.......ooiiiii 2008-2009 L. Dobreen
E Projects > TCS — Boiler Replacement.........cooveiiiiiiiii e 2008-2009 K. McNabb
> Douglas — Roof Replacement...........cc.oiiiiiiiiii e, 2008-2009
1.5 > Rivers Collegiate - Gym Floor Structural...........cooooiiiiniiiiii 2009-2010
) > Elton Collegiate — Music ROOM...... ..o 2009-2010
P MO = SHrUCUral. ... e 2010-2011
> Heating and ROOfiNG. ... Ongoing
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2008 - 2009 to 2010 - 2011

Divisional Goal / —_— Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report

Grounds > Year 4 of 5 year plan to repair/upgrade & maintain parking lots in the L. Dobreen
Maintenance DVISION. et 2008-2010

»n | 1.6 > Grounds development at FOrrest............ooveviiineiiiiieeiiiieeeeeeeeenn, 2008-2009

c

-_lg Computer > Complete cabling and electrical upgrade and ability of all schools to 2008-2009 L. Dobreen

m Wiring in support technology needs and plans for schools (Final Year)

ot Schools e Additional 1.0 FTE Term Electrician to Dec. 31/08 L. Dobreen

QO e Erickson Elementary K. McNabb

Q. 20 > Working with G. Butler on BATL Classrooms

O > Discuss potential for shared services for Term Electrician with

> neighboring Divisions

—

— Professional | Provide > Continue with WSH Training 2008-2009 L. Dobreen

O Development | training for > Arrange P.D. session for Custodial staff

© staff > Continue working on Job Hazard Analysis and with Workplace Health

LL 3.0 Safety

~ .

Q

o

c

(1] Accountability| Maintenance | » Research, purchase and implement a Work Order and Inventory 2008-2010 L. Dobreen

cC Inventory & Program K. McNabb

(¢} Work Order G. Butler

-IE Program

= | 4.0

=
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